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How to Use this eGuide

This eGuide was designed to be read with Adobe Reader, which is a free 
program for all Mac and Windows computer users. You can download the 
latest version of Adobe Reader at http://get.adobe.com/reader. Guide 
functionality may vary depending on your reading device.

In addition to reading about your health, you can use this eGuide to:

• Skip to speci�c topics. Click on any section heading to skip to that topic.

• Search for a speci�c topic. On the menu, go to Edit>Find. Type in your 
search word, followed by the Return key. Search results will be highlighted. 
Continue to hit Return key to skip to the next result.

• Look up unfamiliar words. Use the cursor to highlight a word (for example, 
“diabetes”). On the menu, go to Edit>Look Up “diabetes.” Your internet 
browser will open to provide more information about this word.

• Track your health information. Places to enter your information appear in 
blue. Click on any blue �eld and begin typing. Use the Tab key to skip to the 
next �eld or the Return key if you are done. Don’t forget to save your 
changes before you close the document.

Concerned about keeping your information private? Edit your security 
settings: On the menu, go to Edit>Protection>Security Settings.

• Make note of health questions or concerns about what you are reading. On 
the menu, go to View>Comment>Annotations. Choose Sticky Note. Click 
where you would like to insert a note and begin typing.

• Learn more from internet resources. Click on any web address to open that 
web page in your internet browser.

• Hear the guide read aloud to you. First, activate this feature. On the menu, 
go to View>Read Out Loud>Activate Read Out Loud. Then, go back to the 
same place in the menu to begin, pause, or end reading aloud.
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W hy should you care about your health? Well, there
are lots of reasons—such as feeling good, looking good, and
getting stronger. Doing well in school, at work, and in sports
and other activities can all be affected by how healthy you
are. 

When it comes to making choices about your life, some of
the biggest are those about your health. Your health is your
future, so don’t rely only on yourself and your friends when
making life decisions. Your best resource for accurate
information, advice, and—if you need it—treatment, is your
health care provider.

These Teen Health Guide topics can help you keep
up and keep track!

— Friends & Relationships
— Fitness & Food
— Mental Health
— Health Habits
— Smoking
— Sex & Safety
— Drinking & Drugs
— Resource List
— Personal Phone#
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• Pick people who have similar interests, but don’t rule out thosewho aren’t exactly like you. It’s good to keep an open mind. • If you respect others, others will respect you. • Accept that everybody has quirks and flaws.• Even the best of friends can’t be together 24/7. Develop otherinterests, and don’t be jealous when your friend has otherinterests too. 
• Your friends can’t read your mind. If something is affecting yourrelationship, tell them.
• A good friend will let you vent, but you should always be readyto listen in return.
• Don’t talk behind your friends’ back. They will eventually findout.
• Choose your words wisely, because you can’t take them back.

••friends & relationships

L ife’s not always easy. There will always be stresses such
as exams, work, love stuff, family issues, neighborhood violence,
and more. But when you have problems to deal with, it helps to
know that a friend is there for you. They can feel like the glue
that holds everything together. So how do you find the right
ones?

keys to a good friendship



Friends can change, however. Sometimes they may try out new
things, and you may start to have less in common. It might feel
as if the person you once knew so well has gone away. If you
find that it’s just too hard to agree on stuff, or your friends are
into something that just isn’t you, start to expand your circle of
friends. Try talking to people you might want to get to know, or
checking out school and community clubs, art or music classes,
sports teams, or volunteer work to meet people who like what
you like. What else can you do to make your world better?

Let out your emotions: Let people know how you feel and
ask for their support. It’s a good way of relieving tension.
Connecting with others may make you feel better. 

Be creative: Sketch, paint, journal, even scribble! 

Get active: Make time for your favorite sport or activity, or try
something new. 

Take time for you: Try to relax. Listen to your favorite music.
Read. Take a walk. Do something you like to do by yourself.
Talk about it: If you have a problem, find someone you can trust
to talk to. Maybe a teacher, parent, older brother or sister, other
relative, coach, or friend. Don’t struggle alone—let it out. If you
need confidential help, try calling a helpline or visiting your
school counselor or health care provider.
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talking to parents,
adults, and caregivers

Adults often do not know what to expect from teens. Try these
tips to improve your communication: 

• Be honest with your feelings. Your
parents/guardians may be a source of
support and knowledge, but they don’t
know what’s going on in your life if you
don’t tell them. 

• If you’re upset (don’t like your curfew, got
grounded), don’t take the defensive side
right away. If you start yelling or crying, 
you won’t be able to express your 
important feelings.

Every family has tough times, fights, and anger. 
It is a problem, though, when these situations include hitting,
name-calling, or using a weapon.
That’s called abuse.  If this is
happening, talk to your school
counselor. 

National Child Abuse 
Hotline
1-800-422-4453
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When all else fails, you may feel frustrated, angry, or ready to
explode. This is normal. What matters is how you handle
yourself when you’re angry. One healthy way to deal with it is the
cool-down approach. When something gets you really mad, try
to stop, calm down, and think before you do or say anything you
may regret. Express what is bothering you and why it makes you
angry.  If the situation involves another person, listen carefully to
what he/she is saying:

• Come up with options (other than
fighting and avoiding) for resolving
the conflict.

• If you can’t work it out, get help.
• If someone is confronting you, and

you are worried it will become
violent—leave.

school violence: 
� Start with yourself. Make a promise not to add to violence, including

bullying, teasing, or spreading rumors. Respect others and value
differences.

� Do not carry a gun or any other type of weapon, including pocket 
knives.

� Report anyone that you know is carrying a weapon.

making peace —
managing conflict

violence —
what can you do?
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Date in groups and meet in public places.

Follow your gut feelings about a person.

Extreme jealousy, threats, and controlling behavior
can lead to violence.

Be clear about what you want and don’t want; 
never give mixed messages. 

Try not to rely on a date for a ride home or money.

Avoid alcohol, drugs, and parties where they flow
freely. 

Find out about dating abuse so you know what to
watch out for and what to do if it happens. Good sites
to check out are loveisnotabuse.com, chooserespect.org,
and safeyouth.org.

tips for safe dating

dating abuse:

Learn as much as you can about this serious issue so you

can avoid danger and just have fun. You can trust yourself 

to make good decisions. People who pressure you into

things only care about their own power.  They may not be

respecting your wishes. If you are forced to have sex when

you don’t want to, that’s rape. Forced, unwanted sex

between two people who know each other is date rape. 

It’s a serious act of violence and it’s illegal. Dating abuse 

is not just sexual or physical, either — threats, insults, and

public humiliation count as well.

http://www.loveisnotabuse.com
http://www.chooserespect.org
http://www.safeyouth.org
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Know that if you feel pressured to do something
you don’t want to do, it is your right to:

• Change your mind. 
• Say “no” and mean it.
• Leave a situation where the pressure

is too much.
• Leave if you sense that you are in

danger. 
• Accept no open drink, unless you

watched it being poured. 

If you’re in a relationship that in any way feels
uncomfortable, awkward, tense, or even frightening, trust
your feelings and get out of it.

You may need help to leave a violent relationship.  Talk with
someone you trust. You can also call the National
Domestic Violence Hotline at 1-800-799-SAFE (7233).
If adults in your life tolerate violence in their relationships,
you may need extra support to avoid violent relationships in
your own life.
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You may be revealing a lot about
yourself on social networking sites.
People who want to take advantage of
children and teens can use personal
details to fool the writers into believing 
that they know them—don’t be one of
their victims. 

Taking the right actions at the right time can save you
from getting into a lot of trouble:
� If you find yourself on a suspicious site in error, click

off it right away.
� If a stranger emails you, never answer them.
� Avoid chat rooms in which people are asking you for

personal details or talking in language that you know
is not appropriate.

� Use networking sites with caution. Make your profile
private so it’s only available to trusted friends.

� If you write and post your own blog, make sure it
does not contain any personal information that could
put you at risk.

� Let your parents/guardians monitor or restrict your
online activity.

� Tools to help you have a safer online experience at
netsmartz.org.

online safety —
what can you do?



On your own or with your friends, what will more
activity do for you?

� Keep your appetite and weight under control.
� Make you feel better and give you more energy.
� Help you see your body in a positive way. 
� Help you feel less bored and depressed.
� Help you handle stress.

••fitness & food

how do i look?
how do i feel?

A s your body changes, so does your image of yourself.
Self-esteem is about how you value who you are. Appreciate
your body no matter what shape, size, or color it is. Keep it
healthy with good eating and physical activity habits.

exercise
• Be active for 60 minutes each day.
• Have fun. Try walking, running,

swimming, biking, or dancing. Team
sports are great, too.

• Do warm-up exercises for 5–10
minutes before exercising and cool
down after you’re done.

• Increase exercise gradually.

9
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Pay attention to what, when, and how much food you eat.
Start healthy habits now that will stay with you for life.

�Eat breakfast to wake up your body and your mind.

�Avoid greasy foods and sweets. 

�Stick to regular servings — don’t supersize!

�Eat when you’re hungry, not when you’re bored.

�Choose foods low in saturated and trans fats, cholesterol,
and salt. 

�Snack on fruits and vegetables, look for the dark green, red
and orange veggies. Aim for 5 servings each day.

�Soft drinks, fruit juices, and sports drinks are loaded with
sugar.

�If you eat while watching TV, you’ll probably eat more than you
intend to.

�Get calcium for strong bones from low-fat milk, yogurt and
cheese. 

�Choose whole grain for bread and cereal.

�Try fish as a source of protein, as well as lean meat, poultry,
eggs, and unsalted nuts.

eat healthy
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find your BMI

Many teens are overweight because of too little activity and the
way they think about food. The best way to avoid many major
health problems is to maintain a normal weight. Instead of
dieting, build healthy eating patterns with meals and snacks.
See at a glance if you are at a good weight, or need to start
shedding some pounds:

weight

Healthy: 19–24
Overweight: 25–29
Obese: 30+

19 20 21 22 23 24 25 26 27 28 29 30
4’8” 91 96 100 105 110 115 119 124 129 134 138 143

4’9” 94 99 104 109 114 119 124 128 133 138 143 148

5’0” 97 102 107 112 118 123 128 133 138 143 148 153

5’1” 100 106 111 116 122 127 132 137 143 148 153 158

5’2” 104 109 115 120 126 131 136 142 147 153 158 164

5’3” 107 113 118 124 130 135 141 146 152 158 163 169

5’4” 110 116 122 128 134 140 145 151 157 163 169 174

5’5” 114 120 128 132 138 144 150 156 162 168 174 180

5’6” 118 124 130 136 142 148 155 161 167 173 179 186

5’7” 121 127 134 140 146 153 159 166 172 178 185 191

5’8” 125 131 138 144 151 158 164 171 177 184 190 197

5’9” 128 135 142 149 155 160 169 176 182 189 196 203

5’10” 132 139 146 153 160 167 174 181 188 195 202 209

5’11” 136 143 150 157 165 172 179 186 193 200 208 215

6’0” 140 147 154 162 169 177 184 191 199 206 213 221

6’1” 144 151 159 166 174 182 189 197 204 212 219 227

6’2” 148 155 163 171 179 186 194 202 210 218 225 233

height

weight
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••mental health

body image disorders

Warning signs of anorexia include: • Intense fear of gaining weight, even whenunderweight.
• Weight loss of at least 25% of original body weight.• Distorted body image (claiming to be fat when not).• Refusing to maintain healthy body weight.

Warning signs of bulimia (binging and

purging) include:
• Out-of-control eating that happens often.
• Making yourself throw-up. 
• Use of laxatives or “water pills.”
• Excuses to go to the bathroom right after meals.

These mental health diseases can lead to
dangerous medical problems and even death.
Fortunately, there are treatments that can help
people fully recover. Check with your health 
care provider if you experience any of these
warning signs.

Warning signs of binge-eating:
• Eating to the point of pain.
• Often eating alone. 
• Hoarding food.
• Feeling upset or disgusted about how much you’veeaten.
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depression —
take it seriously

Most teens feel sad or upset sometimes — especially
with the pressure of relationships, family, and friends. If
you are experiencing more than one of the symptoms
below, talk to someone you can trust, such as a parent,
teacher, health care provider, or a clergy member.
These adults can help decide if you need to meet with
a professional who can help you find solutions to feeling
good again.

Feeling sad sometimes and having mood swings is
normal, but being depressed for a long time is not.
These are signs of depression, especially if they last for
more than two weeks: 

�Changes in eating or sleeping habits.
�Sadness that won’t go away.
�Loss of interest in what used to be fun or interesting.
�No longer hanging out with friends.
�Loss of energy or motivation.
�Thoughts of harming or killing yourself.
�Anger and rage.
�Using drugs or alcohol to “forget” about problems.
�Overreaction to criticism.
�Lack of concentration, forgetfulness, or extreme

pessimism.
�Aches and pains that don’t get better with treatment.
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Talking about your feelings is often the first step to feeling
better. Hurting or killing yourself is never the answer. If you
feel you need extra help, treatment may be for you, and
typically includes counseling and/or medication. 

Have you heard someone say that people who talk about
suicide won’t actually go through with it? That’s a myth—
people who talk about it may try it. If you have a friend
who is talking about suicide, don’t wait to see if he/she will
feel better. 

How about if your friend says, “Don’t tell anyone”? You
need to let him/her know you can’t do that. Listen openly,
and then help your friend find someone who is trained to
deal with these situations. If your friend either has a
detailed plan or appears suicidal and will not talk, do not
leave him/her alone. Get help right away.

If you are thinking of hurting
yourself or someone else, get help
now. If you feel there is no one you
can talk to, call the National Suicide
Prevention Lifeline at 1-800-273-
8255. There is always someone
there who wants to listen and help
you.
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If you ever harm yourself on purpose, seek help. If you
see a friend doing it, talk to about it and be supportive,
but encourage him/her to get help too. Never ignore this
situation. Teens who are abusing themselves often try to
hide it by covering up their body with clothes in warm
weather or not explaining visible cuts and marks. It is a
very serious problem which could lead to suicide, but the
good news is that it can be treated. Act right away and
involve a trusted adult.

Warning signs of suicide include:

• Suicide threats.
• Talking about death or feeling helpless/hopeless.
• Overwhelming sense of guilt, shame, or reflection.
• Giving away things you valued.
• Thinking about suicide plots and planning how to

do them.
• Poems, essays, and drawings that refer to death.
• Dramatic change in personality or appearance.
• Changed eating or sleeping patterns.
• Severe drop in school or work performance.

self-injury



Your health care provider would like to see
you once a year. If you have a condition such
as allergies, asthma, or diabetes you may
need to be checked more often. If your family
does not have health insurance, you may
qualify for insurance from your state. Ask
your health care provider to help all of you
enroll.

When you go to the doctor, you’re probably used to being
asked questions. Be sure to answer them all honestly, even
if you feel embarrassed. You too can ask questions about
anything you’d like. Do you have questions about sex and
STDs (sexually transmitted diseases)? Who can you talk to
about family/friends problems? Can you get help to quit
smoking? 

Physical exams are a good time to get information. Make a
point to learn about any medicine, tests, or treatments that
may be needed.

16

••health habits

Being a teen includes developing independence. Knowing
about your health is part of this and includes keeping
appointments, taking medicine correctly, and following advice.
Protecting your health is a lifelong process — be the person
who is most concerned about it!

taking control —
seeing your doctor
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Measles, Mumps,
Rubella

Tetanus,
Diphtheria,
Pertussis

Chicken Pox

Meningococcal

Pneumonia

Hepatitis A

Hepatitis B

Date Doctor/Location

Human
Papillomavirus

Inactivated
Poliovirus

Immunizations protect you from
serious diseases.immunizations

Record

Influenza

Date
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Blood
Pressure

Weight / BMI

Height

Dental

Eye Exam

Lipid Panel

health screenings
and tests record

Date/
Results Date/

Results Date/
Results
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Date/
Results Date/

Results Date/
Results Date/

Results

Write down the date and results when you have these exams.
Check with your doctor for specific recommendations.
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health screenings
and tests record

Date/
Results Date/

Results Date/
Results

Testicular
Exam

Depression

STDs

Chlamydia

Urinalysis

Skin Exam



21

Date/
Results Date/

Results Date/
Results Date/

Results

Write down the date and results when you have these exams.
Check with your doctor for specific recommendations.



health care providers /
dentist / advisors

_____________________ _____________

_____________________ _____________

_____________________ _____________

_____________________ _____________

_____________________ _____________

_____________________ _____________

_____________________ _____________

_____________________ _____________

_____________________ _____________

Name Phone
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Young Men: Examine your testicles to help find testicular
cancer, one of the most common types of cancer in young
men. Do this self-exam every month starting at age 15:

� The best time is after bathing when heat causes the skin of
the scrotum to relax.

� Look at the scrotum for swelling.
� Examine each testicle by rolling it between your thumb and

the first two fingers of both hands. It is normal for one
testicle to be larger than the other.

� Check for lumps, swelling, tenderness, or a change in size
of the testicle.

� Feel the cord-like structure on the top and back of each
testicle. 

� Tell your doctor about aching in the lower belly or groin, or
a heavy feeling in the scrotum. 

self exams

� When you get into the habit of checking out your
body, you’ll be prepared to tell your health care provider
about any lumps or changes that you may find. 

Limit your time in the sun (and tanning salons) to
protect your skin and prevent skin cancer. Check for
and report any new or changed moles on your skin.
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You can decide to protect your health by never starting to
smoke. If you do smoke, now is the time to quit. Tobacco use
kills more than AIDS, car fatalities, alcohol, suicides, homicides,
fires, and illegal drug use combined. It is the single most
preventable cause of death in the U.S.

Nicotine, found in
tobacco, is a fast-acting
drug that affects the
nervous system and is
very addictive. It is the
most widely used drug
in the country. Some
smokers report that they
relax while using, but
others get irritable and
nervous. 

Smokeless tobacco (“chew” or “snuff”) is not safer. Some
varieties have higher levels of nicotine and are more addictive.
Using it can lead to mouth cancer, will make your heart beat
faster, and will increase your blood pressure. It has high sugar
content, causing tooth decay. Loose teeth, receding gums,
stained teeth, spitting, bad breath, and sores in the mouth are
just a few of the results from using ”chew.”

••smoking
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Teens that use tobacco:

� Have increased risk for future cancers, lung diseases, heart
problems, and stroke.

� Find it harder to be active in sports due to shortness of
breath.

� Develop yellow teeth and get wrinkles faster.
� Smell — their hair, clothes, and breath.
� Waste money on cigarettes.

There are plenty of good reasons to quit, but it’s tough to
break an addiction. These tips can help you quit:

� Make a date and a plan to quit and stick to it.
� Get rid of reminders such as ashtrays and lighters.
� Wash or air out items that smell like smoke.
� Get rid of your cigarettes.
� Try gum instead of “chew.”
� Stay away from alcohol.
� Stay busy to keep your mind off cigarettes.
� Stay away from smokers, at least while they are

smoking.

Despite all the tobacco use on TV, videos, and movies, most

teens, adults, and athletes don’t use it. Of the adults that do,

90% started when they were teens, never thinking they’d get

hooked. The tobacco companies need new smokers to replace

the 1000 plus who die each day from smoking-related illnesses

— don’t be one of them!
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••sex & safety

One of the toughest decisions teens face is whether or not
to have sex. You also have time to wait until you are totally sure
about it. If you decide to wait for sex, it’s ok. You’re just checking
out your options before you do anything you may not be ready
for. You’re also in the majority—53% of high school students are
waiting to have sex.

Whether you choose to have sex or not, it's good to know about
safe sex and how sex affects your health. If you’re in a
relationship that continues to the point where you’re ready to
have sex, you need to talk about protecting yourself and your
partner from unplanned pregnancy and sexually transmitted
diseases (STDs). If you’re having sex, protect yourself.

You can trust yourself to make good decisions about
relationships and sexual boundaries. It is your right to:

Change your mind.
Say “no” and mean it.
Decide for yourself what you think is right.
Leave a situation where the pressure is too much.
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contraception

Plain and simply put, contraception (birth control) is both
partners’ responsibility. Every time a woman has sex with a man
there is a risk of pregnancy. The most effective method of birth
control is abstinence (no sexual intercourse). For those that do
have sex, there are many contraceptive methods available.

Condoms can be an effective birth-control method. Proper use
of them, however, means more than slipping one on in the heat
of the moment. Be sure to carefully read the instruction sheet
that comes with it. And most importantly, use one every time you
engage in sex. 

Other methods include female condoms, diaphragms, cervical
caps, hormonal methods (pill, shot, patch, ring), and long-acting
IUDs and implants. These options require a visit to a health care
provider or clinic.
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About 1 in 4 sexually active teens get an STD.
These infections are usually passed from
person to person through many forms of
sexual contact, not just intercourse. Two-thirds
of people with STDs get infected before age
25! If you think you can “tell” if someone has
an STD, you’re wrong. While some infections
have symptoms you can see, many can stay in
your body for years without any signs at all.
Talk with your partner to avoid STDs. 

You can reduce your risk of getting an STD.

� Keep condoms available.

� Avoid sex when drunk.

� Refuse to do what you’re not comfortable with. 

Most STDs that can be transmitted through
intercourse can also be spread orally.
Remember, not all contraceptives protect
against STDs and AIDS. Condom use does
reduce the risk of many STDs. The only way
to stay totally safe from STDs is not to have
sex. It's never too late to abstain from sex,
even if you've had it already. 

sexually transmitted
diseases (STDs)



Chlamydia is the fastest-spreading STD. Untreated, it can
lead to sterility (cannot become pregnant) and other health
risks. Checking for it is important because there are rarely
any symptoms. Sexually active women under age 24
should get tested. When found, it is treatable. 

Gonorrhea is one of the most common and curable
STDs. Bacteria that live in warm, moist areas of the body
cause it; so don’t think that oral sex is risk free! People with
this infection may not know they have it. They can spread it
to their partners and never realize it. 

Genital HPV infection is caused by the human papilloma
virus (HPV). Many strains of this common STD can infect
the genital area. Some may cause cancer of the cervix,
anus, and penis. Others may cause genital warts. It can be
prevented with the HPV vaccine. 

Herpes is a painful infection caused by two viruses that
are easy to catch. You can carry the virus, not show
symptoms, and still spread it. Herpes is treatable but not
curable.

Syphilis is a dangerous, even fatal, bacteria-based STD.
It is found in painless sores or rashes on the skin, inside
the mouth, or on genitals. Contact with these sores will
infect you, too. Syphilis travels through the blood and can
attack your heart, brain, and spinal cord. It is curable in the
early stages, but once damage is done it can’t be reversed.

types of STDs
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HIV/AIDS. The human immunodeficiency virus (HIV)
causes acquired immunodeficiency syndrome (AIDS). It is
transmitted when body fluids infected with HIV are
exchanged. Infection occurs when the virus gets into your
blood. Having unprotected sex (without a condom) with
someone infected with it is the most common way to get
HIV. There is no cure for HIV/AIDS. The best way to
combat the virus is to keep from getting it.

Hepatitis B (HBV) is a virus that often causes a chronic
infection and liver damage. HBV is spread when blood and
body fluids come into contact with breaks in the skin or
other body surfaces. Safer sex (correct condom use) and
avoiding non-sterile needles will help prevent the spread of
HBV. If you are thinking about getting a tattoo or body
piercing, you might get infected if the tools have someone
else’s blood on them. Do not share personal items that
might have blood on them (razors, toothbrushes). There is
a vaccine for HBV.

� If you are sexually active, see your health care provider
regularly and be honest about your sexual history. The only
way to find out if you have an STD and be treated is to get
tested. Many clinics and county health departments offer free
or low-cost confidential testing and treatment. 
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••drinking & drugs

Drinking is bad for your health — seriously! It affects your
brain, your body, and your self-control — it can also kill you.
Injuries kill more teens than all diseases combined, and most of
them are due to car crashes. Most fatal wrecks happen at night,
and alcohol is part of many of these deaths. Your chances of
drowning also go way up when you drink. 

Despite what other teens may tell you, or what you see on TV
and in movies, it is never cool to drink, and it often makes
people do stupid things. You may end up feeling embarrassed,
stressed, and feeling worse.

To help prevent a car crash and increase your
chances of surviving:

� ALWAYS wear a seatbelt. Most accidents happen close to
home.

� Drivers, ask everybody to
buckle up!

� If you have been drinking or
using drugs, don’t drive.

� Don’t ride with someone who
has been drinking or using
drugs.

� For every passenger in the car,
your odds of getting into an
accident go up.

31
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If drinking and/or drug use might be a real
problem in your life, take this test. 
Check the boxes if you:

Get drunk or high on a regular basis.

Lie (even to yourself) about the amount of drugs or alcohol
you use.

Think you need to drink or get high to relax or have fun.

Constantly talk about drugs or drinking.

Feel depressed or suicidal.

Forget what you did while drunk or high.

Give up stuff you used to do, and drop friends who don’t use
drugs or drink.

Drink or use drugs alone.

Get suspended from school or miss work because of drinking
or drug use.

Get into trouble with the law.

Are broke because of drugs.

If you have checked one or more of these boxes, or if you
suspect that someone you know has these problems, get

help now.  See the Resource List on pages 38-39.



You’re responsible for your body and how you treat it. Drugs can
ruin your life. It’s that simple. They will not help you think better,
be more popular, have a better time, or be a better athlete. If you
have problems, drugs won’t solve them. Getting high can make
you forget, so you care less about yourself or your friends. If you
feel pressured to have sex when you don’t want to, drugs may
make it even harder to say no or may lead to unsafe sex.

Drugs affect your brain, body, and self-control. Many can 
be addicting, are against the law, and can kill you, especially if
combined with alcohol. 

So what are the main ones?

Bath Salts (Plant food, Incense, Ivory Wave,

Purple Wave, Vanilla Sky) is a powder laced
with chemicals, acting as a stimulant and
hallucinogen. 

Cocaine (Coke, Crack, Blow, Snow, Nose

Candy, White, Big C) is very addictive. Using
cocaine can make you feel paranoid, angry,
and hostile, even when you’re not high. It
impairs your judgment. Even first-time users
can have seizures or heart attacks.
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Ecstasy (E, X, XTC, Roll) is part stimulant and
part hallucinogen. It can alter mood, memory,
and thinking. Long-term use can damage your
liver, kidneys, motor skills, and memory.

GHB (Liquid Ecstasy, G, Georgia Home Boy)

is a date-rape drug. It slows breathing and
heart rates to dangerous levels. As little as one
capful can cause seizures and stop breathing.
Overdoses can be fatal. Since it is a clear
liquid it can be added to drinks and you’ll never
know. So, be careful not to leave your drinks
where others can dose them. Only let people
you trust get a drink for you.

Inhalants (hair spray, gasoline, spray paint,

glue) are poisonous. Sniffing them can lead to
brain damage and even death.

Ketamine (K, Special K, Vitamin K, Cat

Valium, Bump) causes memory loss and loss
of pain. The liquid can be hidden in drinks, the
powder sprinkled into cigarettes or joints.
Overdoses lead to extreme confusion and
death.
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LSD (Acid, Blotter, Doses, Microdots) is a
hallucinogen. It comes in vials, sugar cubes,
gel wafers, pills, or blotter paper.

Marijuana (Weed, Pot, Grass, Herb, Reefer,

Blunts, Ganja) affects your memory, self-
control, judgment, and your health. One joint
affects the lungs as much as four cigarettes.

Methamphetamine (Speed, Ice, Chalk, Meth,

Crystal, Crank, Fire, Glass, Crypto) is a
stimulant. It is addictive and causes
hallucinations, insomnia and paranoia.
Psychotic or violent behavior, and severe
depression are also serious effects of long-
term use.

Spice (Potpourri, Herbal incense, K2, Zic

Zac, Moon Rocks) is smokable potpourri laced
with synthetic marijuana.
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OTC (over-the-counter) and prescription
drugs are not any safer and are just as illegal
if you abuse them. OTC drugs are cough and
cold medicines (Triple C, Candy, Dex, DM,
Drex, Red Devils, Robo, Rojo, Skittles, Tussin,
Velvet, Vitamin D). They can cause a variety of
symptoms including hallucinations, vomiting,
high blood pressure, seizures, brain damage,
and death.

Prescription drugs are oxycontin, vicodin,
xanax, valium, and ritalin. Doctors may provide
them to relieve pain and calm nerves and
muscles. When taken in high doses, or with
alcohol, they cause loss of body control and
even death. Never take anyone else’s
medicine, and only take your own in the right
dose.

Opiates (Heroin, Morphine, Codeine) are very
addictive. Over time, heroin use destroys your
body. If you share needles to use it, you are at
risk for catching HIV/AIDS.

Rohypnol (Roofies, Forget-Me-Pill, Roach) is
a date-rape drug, dissolving easily in
carbonated drinks.
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If you have a friend who has a problem with
alcohol or other drugs, be a real friend and urge
him/her to get help. Things can get much worse.
If they don’t get help, serious problems can
develop such as suicidal depression, liver
damage, and brain damage. Substance abuse
can cause your friend to drop out of school,
lose friends, lose values, lose self-respect, and
even lose his/her life.

Your friend will not be able to solve this problem
alone. A good counselor will be supportive and
direct him/her to the kind of treatment that is
most helpful. See the Resource List that follows.

Steroids are taken to help build muscle. But,
like all other drugs, they have some pretty
nasty side effects. They can lead to mood
swings and aggressive behavior, weaken your
immune system, slow down your growth, and
lead to liver damage and cancer. In males they
can cause testes to shrink, sperm count to
drop, and cause loss of head hair. In females,
they can stop your periods, cause loss of head
hair but growth of body and facial hair, and
deepen your voice.



The following sites will give you more information on the
topics covered in this booklet. The phone numbers are
there for you to use if you need them:

National Domestic Violence Hotline
1-800-799-SAFE (7233)

National Runaway Switchboard
1-800-RUNAWAY (786-2929)
www.1800runaway.org

National Child Abuse Hotline
1-800-4-A-CHILD (422-4453)
www.childhelp.org

National Dating Abuse Helpline
Love is Respect
1-866-331-9474
www.loveisrespect.org

National Sexual Assault Hotline
1-800-656-HOPE (4673)
www.rainn.org

On-Line Safety 
www.netsmartz.org/teens
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Good Eating 
www.choosemyplate.gov

National Suicide Prevention Lifeline
1-800-273-TALK (8255)
www.suicidepreventionlifeline.org

Health 
www.kidshealth.org/teen
www.girlshealth.gov

Quit Smoking
1-800-QuitNow (784-8669)

Sexual Health 
www.iwannaknow.org 
www.sexetc.org 
www.pflag.org

STDs Hotline
www.ashastd.org
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Name Phone

____________________________ ________________

____________________________ ________________

____________________________ ________________

____________________________ ________________

____________________________ ________________

____________________________ ________________

____________________________ ________________

____________________________ ________________

____________________________ ________________

____________________________ ________________

Information in the this Health Guide is for education only. It does not replace medical
advice or attention. Always consult a physician or other medical professional for
advice on illness or injury. We can accept no responsibility for any problems that may
develop.
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